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REQUIREMENTS 

At least two MetaTrader 4/5 platforms 

Windows 7/Windows 8/8.1/10 

Microsoft .NET Framework 4.6.1 
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FOREX COPIER 3 QUICK START 

If you don’t have our program please download the Forex Copier 3 here: 

https://forexcopier.com/download/DownloadLinkTradeCopier3 

1. Open Forex Copier 3 installer. 
 

2. Read End-User License Agreement (EULA) and click on “I Agree” checkbox if you agree with EULA 

terms. 

 

3. Choose folder and click “Install”. 

 

4. Wait for the installation to be finished. 

https://forexcopier.com/download/DownloadLinkTradeCopier3
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5. Click “Add source” button. In “New source configuration” window, which will appear, please choose 

the Meta Trader 4/5 platform from the list. Then click “Save” button. To add another Source 

account, please repeat the operation again. Please choose Receiver platform(s) by clicking “Add 

Receiver” button. 

 

 

6. Please choose “Use all default copying settings” and click “Save”. 
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7. Please make sure that there is connection arrow between Source and Receiver accounts, click on 

“Apply scheme” button, open Source and Receiver platforms and start copying orders! 

 

 

FOREX COPIER 3 INSTALLATION 

If you do not have Forex Copier 3 installed on your computer, you can download it here:  

https://forexcopier.com/download/DownloadLinkTradeCopier3 

1. Open Forex Copier 3 installer 

2. Read End-User License Agreement (EULA) and click on “I Agree” checkbox if you agree with EULA 

terms. 

https://forexcopier.com/download/DownloadLinkTradeCopier3
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3. Choose folder and click “Install”. 

 

 

 
8. Wait for the installation to be finished. 
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Congratulations! Installation is completed! 
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IMPORTANT INFORMATION 

 
 

Starting from Windows Vista, Microsoft has introduced a restriction on writing to Program Files directory. 

If User Account Control (UAC) system is enabled, programs are not allowed to store their data in Program 

Files folder. All data should be located in a separate user directory. 

In the new MT4 and MT5 versions, all data of a certain user working with a certain copy of the terminal is 

stored in a special place called “Terminal data folder”. It can be opened via File -> Open Data Folder 

menu in the MT4/5 platform. 

 

 

 
 

If the following folder is opened: 

C:\Users\<User name>\AppData\Roaming\MetaQuotes\Terminal\<InstanceID> 

Then UAC is enabled on your computer and you can continue Forex Copier 3 installation, our software will 

work properly on your computer. 

 
 

If MT4/5 terminal path is opened, for example: 

C:\Program Files (x86)\MT4 

then you need to turn on UAC on your computer in order for our program to work. 
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HOW TO TURN ON USER ACCOUNT CONTROL (UAC) 

 
 

1. Type UAC in the search field on your taskbar. 

2. Click Change User Account Control settings in the search results. 

3. To turn UAC on, drag the slider up to the desired level of security and click OK. 

4. You may be asked to confirm your selection or enter an administrator password. 

5. Reboot your computer to apply changes. 
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FOREX COPIER 3 REGISTRATION 

1. To register Forex Copier 3 please click on Register->Register program on main menu. 

 

 

 

2. If you have Forex Copier license then please enter your name, email and license key into proper 

fields below and click "Activate" button. 
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3. If the registration is finished successfully you will see "The product has been successfully 

registered" message. 

 

 

FOREX COPIER 3 CUSTOM CONFIGURATION 

 
1. Click “Add source” button. In “New source configuration” window, which will appear, please choose 

the Meta Trader 4/5 platform from the list. Then click “Save” button. To add another Source 

account, please do this operation again. Please choose Receiver platform(s) the same way. 
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2. Please check “Configure custom copying settings” and change needed settings. Please, see full list 

of settings configuration below. Do the same with Receiver account. 
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3. After that, click “Apply scheme” button to start copying. 

 

 
FOREX COPIER 3 FEATURES 

 
You can copy trades from many accounts to many other accounts, which are running on your 

computer. 

For example, you manage your own account(s) and several other accounts with different sizes (or 

even different brokers), in this case you can make trades on your account only but anyway all 

these trades will be copied to all other accounts automatically and the size of orders will be 

adjusted according to the size of that accounts. 

You can copy all trades, which were made on one MetaTrader 4/5 account to another MetaTrader 

4/5 account. 

• Accounts can be of different brokers 

• It does not matter if these trades were made manually or by EA. 

• It does not matter if these accounts are demo or real. 

• It does not matter if the broker supports "Market execution" or "Instant execution". 

• Copier can process orders from 4-digit account into the 5-digit account and vice versa. 
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• It is not a problem if your Source/Receiver account has either prefixes or suffixes. 

• You can have more than one Source account. 

• You can copy reversed trades from some losing account (or losing EA). In this case your account 

will grow. 

• BUY order will be copied as SELL 

• SELL order will be copied as BUY 

• SELL Stop order will be copied as BUY Limit 

• SELL Limit order will be copied as BUY Stop 

• BUY Stop order will be copied as SELL Limit 

• BUY Limit order will be copied as SELL Stop 

 
 

SOURCE FEATURES 

• Can set different lot multipliers for each receiver account. 

 

• Can remove symbol prefix or suffix if source symbol name differs from receiver symbol name. 

• Can control which type of signals are allowed to copy (Buy, Sell, Pending Orders etc.). 

• Can stop trading based on equity or drawdown percent. 

 

 

RECEIVER FEATURES 

• Can set maximum difference (in pips) between opened orders on source and receiver accounts, 

slippage and expiration minutes (maximal order age). 

 

• Can set number of tries of placing order which Receiver Expert Advisor will do if order wasn’t 

opened from the first time. 

• Can auto adjust lot size on receiver account based on balance on source and receiver accounts. 

• Can set lot multiplier to adjust the lot size. 

• Can set custom fixed lot size. 

• Can reverse trades (with or without SL and TP), where Buy order will be Sell order and Stop Loss 

will be Take profit (and vice versa). 

• Can set Stop Loss and Take profit in pips. 

• Filtering trades based on comments and symbols. 
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• Opening trades based on risk percentage. 

• Can set maximal number of orders (for all orders and per each symbol type). 

• Can auto adjust symbol names even if their names differ a bit. 

• Can add symbol prefix and suffix if Receiver symbol name differs from Source symbol name. 

• Can stop trading based on equity or drawdown percent. 

 
NEW FEATURES! 

 

All the features are described conveniently on the left side of the screen when you enter the Settings 

menu. Use them instead of making changes in a tangled and complicated Input menu of 

Metatrader4. 

“Current orders” for a visual comprehending and tracking your open trades by dragging the filter 

name into the header above it. Now it is easy to organize your trades by the account name, by 

the current market price, symbol, stop loss, take profit, lot, time and many other criteria. 

“Copying history” allows you to see the quantity and the quality of the previous trades. You can 

analyze whether the setups you have managed worked or not and if they worked accurately 

enough. 

Forex Copier 3 version is now compatible with MT5 platforms. You can now copy orders between MT4 

and MT5 platforms. 

Added an ability to run all Source and Receiver MetaTrader platforms by clicking “Run all terminals” 

button in the program. 

If any issue appears, you will see a reason of the error in the program window near to a problem 

account 

Added an ability to automatically fix problems with copying. 

Added many new features, you will find their detailed descriptions below. 

 
SOURCE FUNCTIONS DESCRIPTION 

To configure Forex Copier Source you should press “Settings” in Source MT4/5 terminal box. 

Account configuration will open: 
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1. General - here you can change Source platform and its name. In addition, you can enter a number 

of allowed account(s) there, in this case our software will work on this account only and it will be 

disabled if you change an account to another one. 

Also here you can activate the autofix manager, in this case our software will try to resolve all the issues 

automatically. 

 

 
2. Lot/Risk management – allows you to choose the method of lot calculation for copied orders. 
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• Send exact lot size from this Source account to all Receiver account(s) – lot size of copied orders 

will be the same as on Source account. 

• Use custom lot size – here you can select necessary option which allow you to change lot size of 

copied orders. It allows you to decrease or increase resulting lot to suit your requirements to your 

account. 

Multiply every lot by - lot size of copied order will be multiplied by entered value. 

For example, if you set Multiply every lot by 2 and open an order with lot size = 2 on the 

Source account then this order will be copied to Receiver account with lot size = 4. Multiply 

every lot size by different values for each Receiver account - lot size of copied order will be 

multiplied by entered value for each Receiver terminal. 
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3. Filtering orders - this function allows you to choose what kind of orders you don’t want to be 

copied to Receiver account(s). If “Copy all orders” is enabled, orders will be copied. 

• Filter orders by current profit/loss value – you can set allowed price changes, when orders will be 

copied. You can set loss/profit value. 

For example, if you set this parameter “5 pips” and “profit”, in this case if Source account 

opens Buy order at 1.0000. This order will be copied to Receiver account(s) only when price 

reaches 1.0005 (1.0000+5 pips). 
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• Other properties is for filtering orders by type: you can disable of copying BUY, SELL, pending orders, 

execution orders, BUY STOP, BUY LIMIT, SELL STOP, SELL LIMIT. Also you can set “Do not copy 

Close/Delete” and “Do not copy Modify” properties. 

4. Emergency stop – allows to set stop trading parameter when concrete situations appear. To enable 

this property you should check “Use emergency stop”. 

• Stop copying if Equity level is less than … (in base currency of your account) – when this option is 

enabled Copier will stop sending "Open order" signals to Receiver terminal in case when Equity level 

of this Source account is less than value in “Stop copying…” field. 

• Stop copying if Drawdown Percent is bigger than … – when this option is enabled Copier will stop 

sending "Open order" signals to Receiver terminal in case when Drawdown percent of this Source 

account is bigger than preselected value. 

Drawdown is calculated as the difference between current Equity and maximum historical 

Equity in percentage. 

• Stop copying if Drawdown Value is bigger than … (in base currency of your account) – when this 

option is enabled Copier will stop sending "Open order" signals to Receiver terminal in case when 

Drawdown value of this Source account is bigger than preselected value. 

5. Advanced settings – this input allows to change some advanced settings. Please, note that it is 

not recommended to change it without need. 
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• Remove this prefix from symbol name of copied orders. If the broker has some Prefix in currency 

pair name (like “aEURUSD”) then you need to enter this prefix (“a” in example) into this setting. 

 

• Remove this suffix from symbol name of copied orders. If the Source broker has some Suffix in 

currency pair name (like “EURUSDfx”) and Receiver’s broker has another suffix then you need to 

enter this suffix (“fx” in example) into this setting. 

 

• Show info labels on chart - if this parameter checked then Copier will show the information labels 

in the left-top corner of the chart. 
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• Write advanced logs - if this parameter checked then Copier will write more detailed information in 

log files, this parameter is used for debug purposes. 

 
 

RECEIVER FUNCTIONS DESCRIPTION 

To configure Forex Copier Receiver you should press “Settings” in receiver MT4 terminal box. 

 
 

 

Account configuration window opens: 

3. General - here you can change Receiver platform and its name. In addition, you can enter a 

number of allowed account(s) there, in this case our software will work on this account only and it 

will be disabled if you change an account to another one. 

Also here you can activate the autofix manager, in this case our software will try to resolve all the issues 

automatically. 
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1. Lot/risk management - allows you to choose the method of lot calculation for copied orders. To 

enable this setting please check “Use custom lot size”. 
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Use exact lot size from Source account – if this setting checked, all orders will be copied to 

Receiver with the same lot size. 

Use custom lot size – this property allows to set lot size depend on some terms. 

• Multiply lot size from Source account by - lot that Source EA opens on his account will be multiplied 

by this value. It allows you to decrease or increase resulting lot to suit your requirements to your 

account. 

For example: Source trades on $1000 account, your account is $50000, if you copy Source’s 

trades with the same lot size you will get too small profit. So you can set multiplier 50, and 

when Source EA opens position with lot 0.1 you will get position with lot 5. 

Or for example: Source EA trades on account $200000, your account is $10000. It will be 

dangerous to your account to open the same lot, sometimes it will be impossible. So you 

can set multiplier 0.2 and when Source EA opens position with lot = 10 you will get position 

with lot = 2. If resulting lot is smaller than minimum lot in your MetaTrader then minimum 

lot will be used. 

• Proportional lot based on Source/Receiver Equity ratio – allows to open orders with proportional 

lot size based on Source and Receiver accounts Equity. It allows you to decrease or increase 
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resulting lot to suit your requirements to your account. You can also multiply the result by some 

value. 

For example: If Source account equity (in USD equivalent) is 10000 and original lot size is 2 and 

Receiver account’s is 2000. In this case Receiver account will open on order with 0.4 lot size. 

• Always use fixed lot for copied orders – allows to set any lot size. In this case Source’s lot size will 

be ignored and the lot size for each order on Receiver side will be set according to entered value. 

• Use risk management based on Stop Loss - allows you to manage risk for some specific orders. Lot 

will be calculated due to settled risk percentage. 

For Example: You want orders to risk only 1% of equity if the trade closes by Stop Loss. 

Copier EA will copy the original trade but modify the size of position according to the percentage risk. 

Note that the original order should have the Stop Loss level. 

 
 

• Consider provider’s leverage – If this setting is activated, Forex Copier software will multiply a lot size of 

the order by the differences in leverage on both accounts. 

For Example: if you copy orders from an account with leverage 1:100 to an account with leverage 

1:200 and enable this setting, then Forex Copier software will copy all orders with 2 times bigger 

lot size. 

• Lot size for specific currencies – here you can set a different lot multiple for each symbol. 

For Example: you can set a lot multiplier=2 for EURUSD symbol and lot multiplier=3 for XAUUSD 

symbol, in this case Forex Copier program will copy order with a different lot size for these two 

symbols. 



27  

BUY order will be copied as SELL 

SELL order will be copied as BUY 

SELL Stop order will be copied as BUY 

Limit 

SELL Limit order will be copied as BUY 

Stop 

BUY Stop order will be copied as SELL 

Limit 

BUY Limit order will be copied as SELL 

Stop 

3. Reverse mode - if you want Copier to reverse provider’s trades, then you should enable this 

parameter by checking “Use Reverse mode. Copy opposite orders from Source account”. 

 

In this case Copier will place orders with type opposite to Source’s order type: 

 

 

 

You can also read more information about this feature if you click “What is Reverse mode?” 

link. 

You can choose details of reversing orders: 
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• Reverse Stop Loss and Take Profit - if this parameter checked, then Receiver’s StopLoss will 

be equal to Source’s TakeProfit and vice versa. 

• Consider spreads in reverse mode for pending orders - if the parameter is enabled, then in 

Reverse mode the Pending orders’ entry price will be adjusted according to the Receiver’s 

spread value. See the table below to get more information: 

4. SL/TP settings – this setting allows to adjust stop loss/take profit properties. To enable it, please 

check “Adjust Stop Loss/Take Profit” radio button. 

 

 
 

Stop Loss Pips - defines the fixed Stop Loss value for every copied order, the value should be 

determined in pips (1 pip = 0.0001 for non - JPY pairs, and 0.01 for JPY- pairs). 

Take Profit Pips - defines the fixed Take Profit value for every copied order, the value should 

be determined in pips (1 pip = 0.0001 for non - JPY pairs, and 0.01 for JPY- pairs). 

• Open copied orders without SL/TP – if this item is checked then Source’s Take Profit and Stop 

Loss levels are ignored. 
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• Place SL/TP exactly at Source account prices (even if entry price differs) – in case if this property 

is checked, stop loss and take profit will be placed on Receiver’s account with the same price as 

on Source account. 

• Set fixed SL/TP in pips – here you can define stop loss and take profit in pips (1 pip = 0.0001 for 

non - JPY pairs, and 0.01 for JPY- pairs). Source’s orders will always be copied to Receiver account 

with settled SL/TP. 

For example: If you set StopLoss=50 pips and TakeProfit=30 pips and Source account 

sends Buy order with execution price at 1.0000, SL at 0.9900, TP at 1.0010. Forex Copier 

will set SL at 0.9950 and TP at 1.0030 as it set. 

5. Price adjustments – allows to set specific price frames, the order will be copied only when 

settled price arrive. Please check “Wait for better price before opening/closing market orders.” 

radio button to enable this setting. 

 

• Price adjustments for opening orders – allows to set price frames for opening orders on Receiver. 

Open price on Receiver account should be at least … pips better than original open price 

on Source account. The order will be copied only when settled or better price arrive. 

Open price on Receiver account should be equal or better than original open price on 

Source account. The order will be copied on Receiver account only when the price will be 

the same or better than on Source account. 
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Open price on Receiver account should be no more than … worse than original open price 

on Source account. In this case order opens on Receiver account if the price is better, the 

same or (no more then settled number of pips) worse. 

• Price adjustments for closing orders - allows choosing conditions for closing orders on Receiver. 

 
 

Close order immediately at current market price of Receiver account. The order will be 

closed automatically on Receiver after it closes on Source account despite the price. 

Close when price is at least … or more pips better than Source order close price. In this 

case, order on Receiver account will be closed only if price is better than Source’s price. 

Close when order’s profit is at least … pips. The order will be closed only if it has given 

settled profit in pips. 

6. Filtering orders – allows choosing what kind of orders should not be copied to Receiver 

account. To enable filtering orders option please check “Ignore some orders from Source account” 

radio button. 
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• Filtering rules – this is general information about filtering orders. 

Max difference between Source open price and current market price - here you can set 

number of pips that Source and Receiver prices can differ during copying process. 

For example: if order on Source account is opened with 0.9950 and the settled value in 

this setting is 15, in this case order won’t be opened on Receiver terminal if the price is 

more than 0.9965 or less than 0.9935. 

Ignore orders which were opened … minutes ago or earlier – this setting allows to choose 

how long can market order wait for some conditions till open on Receiver account. This 

setting is 60 minutes by default. 

Currency pairs filter allows filtering orders by symbol name. If this parameter is unchecked, 

the program will process orders for all pairs. If this parameter is checked then only 

specified pairs will be processed. To add currency pair please click on “Edit” button>Add- 

>Save. In this case orders only for this currency pair(s) will be copied to Receiver account. 
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Magic number filter - allows filtering orders according to their magic numbers. If this 

parameter is empty and unchecked then the program will process all orders. If this parameter 

is not empty and checked then only orders with specified magic numbers will be processed. 

To add a magic number please click on “Magic number list”->Add->Save. 

 

• Filter by number of orders 

Ignore new orders if current number of opened orders is … or more – this setting defines the 

maximum number of orders allowed on the Receiver terminal, if the number of orders on this 

terminal is equal or bigger than this parameter then all new tasks from the Source will be 

ignored. 
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For example: You set “Ignore new orders if current number of opened orders is 5 or more.” 

Currently there are 2 BUY orders and 2 BUY STOP orders on Receiver terminal. 

After that you get the new task from the Source (let's say SELL order). This order will be 

processed. 

So you'll have 2 BUY + 1 SELL + 2 BUY STOP = 5 tasks in total. 

After that you get another task from the Source (let's say SELL LIMIT order) this task will NOT 

be processed because the total number of orders on the Receiver terminal is 5 so the task 

will be ignored. 

Ignore new orders for symbol if current number of orders for this symbol is … or more defines 

the maximum number of orders allowed for one Symbol on the Receiver terminal, if the 

number of orders on this terminal for this Symbol is more or equal to this parameter then all 

new tasks from the Source EA will be ignored. 

For example: You set ignore new orders for symbol if current number of orders for this 

symbol is 2 or more. 

Currently there are 2 BUY EURUSD orders and 2 BUY STOP GBPUSD orders on Receiver 

terminal. 

After that you get the new task from the Source (let's say SELL USDJPY order). This order will 

be processed, so you'll have 2 EURUSD orders + 2 GBPUSD orders + 1 USDJPY order. 

After that you get another task from the Source EA (let's say BUY STOP EURUSD order) this 

task will NOT be processed because the total number of orders for EURUSD = 2. 

• Filter by lot size 

Ignore orders with lot size smaller than … lots or bigger than … lots – this setting allow to 

define lot frames, within which the orders will be processed. 

For example: If you set “Ignore orders with lot size smaller than 0.5 lots or bigger than 3 

lots” orders with lots 0.5-3 will proceed, and orders with 0.4 or 5 lot size won’t copy to 

Receiver account. 

Ignore new orders if total sum of lots of current orders is … or more – defines max sum of 

lots. 

For example, you can set “Ignore new orders if total sum of lots of current orders is 10 or 

more”. So if there will be 7 orders on Receiver account: 

SELL with lot 2 

BUY with lot 1 

In this case if Source open order with any lot size, it won’t be processed. Please, note that if 

one of the current orders will be deleted, next order will be processed. 

• Copying orders by type – here you can disable copying of BUY, SELL, Close/Delete or MODIFY 

orders for this Receiver account only. 

• Copy pending orders – here you can disable copying of pending orders by type (BUY STOP, BUY 

LIMIT, SELL STOP, SELL LIMIT) 
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• Whitelist comments – enables copying for orders with specified comments. 

• Blacklist comments – disables copying for orders with specified comments. 

 

 

 

 

 

7. Emergency stop – allows setting stop trading parameter when some situations appear. To 

enable this property you should check “Use emergency stop”. 

• Stop copying if Equity level is less than … (in base currency of your account) – when this option 

is enabled Copier will stop receiving signals from Source terminal in case when Equity level of 

Receiver account is less than value in Stop copying if Equity level is less than. To enable this 

option you should check it. 

• Stop copying if Drawdown Percent is bigger than … – when this option is enabled Copier will 

stop receiving "Open order" signals from Source terminal in case when Drawdown percent of 

Receiver account is better than some value. 

Drawdown is calculated as the difference between current Equity and maximum historical 

Equity in percentage. To enable this option you should check it. 

• Stop copying if Drawdown Value is bigger than … (in base currency of your account) – when this 

option is enabled Copier will stop receiving "Open order" signals from Source terminal in case 
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when Drawdown value of Receiver account is better than some value. To enable this option you 

should check it. 

Close all orders if one of above conditions met – if this setting is checked, all orders will be 

immediately closed if one of conditions happens. 

• Close orders if 

 

The profit reaches a certain percent of the account balance – if this setting is enabled then Forex 

Copier program will stop copying and closes all orders if a profit reaches a predefined % of 

account balance. 

 

The profit reaches a certain value – this setting is enabled then Forex Copier will stop copying 

and closes all orders if a profit reaches a predefined value in USD. 

 
8. Event sounds - defines the sounds to be played when the order or some changes appears. 

Please, click on draw-down menu to choose the sound. 



36  
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• “Copy market order” sound - this setting defines the sound to be played when the new market 

order is opened (for example, OpenSnd.wav). Sound files should be placed to 

"<MetaTrader>\Sounds\" folder. Sound files should have *.wav format. 

• “Copy pending order” sound - defines the sound to be played when the new pending order is 

placed. Sound files should be placed to "<MetaTrader>\Sounds\" folder. Sound files should have 

*.wav format. 

• “Modify order” sound - defines the sound to be played when some order is modified. Sound files 

should be placed to "<MetaTrader>\Sounds\" folder. Sound files should have *.wav format. 

• “Close order” sound - defines the sound to be played when some order is closed. Sound files 

should be placed to "<MetaTrader>\Sounds\" folder. Sound files should have *.wav format. 

Please note that if you want to reproduce settled sounds, you should enable events in 

your terminal (Tools->Options->Events->uncheck Enable). 
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9. Comments management – this setting allows choosing what comment should be attached to 

copied orders. 

• Put original order number from Source into comment on Receiver. In this case Copier puts original 

order ticket into copied order comment. 

• Put original comment from Source into comment on Receiver. If this setting checked, all copied 

orders will have Source’s comment. 

For example: Source’s order has 12345 comment. If this setting checked, order on Receiver 

account will be opened with 12345 comment too. 

• Set this comment for each copied order on Receiver – allows setting the common comment to 

every order. 

For example: You want to differentiate orders that were copied on Receiver account and 

orders that were opened on this account. 

• Set empty comment for each copied order on Receiver – if this setting is enabled then copying 

orders will not have any comments. 

 
 

10. Advanced settings – it is not recommended to change them if you are not advanced user. 
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• Slippage - is used when the signal is sent to the MetaTrader server. Slippage defines maximum 

difference between the price which sent to the MetaTrader sever and actual execution price. If 

slippage is too small then Copier will have to try opening orders many times. If slippage is too 

big then orders on Source and Receiver accounts can be opened with big price difference. 

Slippage is defined in pips, 1 pip = 0.0001 for non-JPY pairs and 0.01 for JPY pairs. 

• Max number of tries to execute order if MT4 cannot open the order – defines how many times 

our software will try to open an order if a broker rejects it. 

• Symbol name mapping - allows to copy orders for the currencies with completely different 

names (for example XAUUSD -> GOLD). Forex Copier has default list of mapping symbols, but 

you can add new symbols or remove them by clicking “Edit” button. 

• Copy at specific time – this setting allows to restrict copying process by time, day of the week 

or day of the month. 

For example: here you can set to copy orders only from 08:00 till 17:00 only on 

Thursday or only from 21st till 29th day of the month etc. 

• Orders will be closed in … minutes – defines a lifetime of the order. 

For example: if you put 120 there, Forex Copier will close the order automatically in 2 

hours after opening it. 

• Allow auto adjusting symbol names - if this setting is enabled then you will allow the Copier to 

adjust the currency pair names automatically. Note, that Add Prefix and Add Suffix fields should 

be disabled in this case. For example, if Source and Receiver accounts brokers have differences 

in currency pair suffixes then Copier will adjust currency pairs names automatically. 
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For example: “EURUSD”->”EURUSDfx”, “EURUSD.”->”EURUSD” or 

“EURUSDfxf”>”EURUSDa”, etc.). 

• Manual symbol name management – allows to adjust the currency pair names with suffixes and 

prefixes manually. (Please, note that Allow auto adjusting symbol names setting should be 

disabled) 

 
Add this prefix to symbol name of copied orders – allows specify the prefix for the name 

of the currency on this account. 

Add this siffix to symbol name of copied orders – allows specify the suffix for the name of 

the currency on this account. 

 
 

For example: If Source account opens order with EURUSDfx symbol name, you should put 

“fx” to Add this suffix to symbol name of copied order. In this case copying will proceed 

successfully. 

• Show info labels on chart – this setting allows to choose whether labels on chart will be shown 

or not. Info labels are the text blocks that will be shown in MT4 with the green and yellow colors 

if the checkbox is on. 

 

• Write advanced logs – if this parameter checked then Copier will write more detailed information 

in log files, this parameter is used for debug purposes. 

• Maximum order size – defines a maximum allowed lot size for a copied order. If received lot size 

is bigger than maximum order size then the order will be copied with a maximum allowed size. 

• Order splitting – if this setting is enabled then Forex Copier program will split one order into a 

few orders if received lot size is bigger than maximum lot size allowed by a broker. 

• Write logs to a file – if this option is enabled then Forex Copier will write logs about each step 

it takes. Please note that enabling this setting can slightly decrease a copying speed. 


